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Typographic Conventions 

Type Style Description 

Example Words or characters quoted from the screen. These include field names, screen titles, 

pushbuttons labels, menu names, menu paths, and menu options. 

Textual cross-references to other documents. 

Example Emphasized words or expressions. 

EXAMPLE Technical names of system objects. These include report names, program names, 

transaction codes, table names, and key concepts of a programming language when they 

are surrounded by body text, for example, SELECT and INCLUDE. 

Example Output on the screen. This includes file and directory names and their paths, messages, 

names of variables and parameters, source text, and names of installation, upgrade and 

database tools. 

Example Exact user entry. These are words or characters that you enter in the system exactly as they 

appear in the documentation. 

<Example> Variable user entry. Angle brackets indicate that you replace these words and characters 

with appropriate entries to make entries in the system. 

EXAMPLE  Keys on the keyboard, for example, F2  or ENTER . 
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1 Kronos Integration Overview 

This guide is for SAP Support or partner consultants to integrate SuccessFactors Employee Central with Kronos 

Workforce Central suite. Integration is through an SAP HANA Cloud Integration process for validated third-party 

time management providers. 

For more information about Employee Central, see the Employee Central Implementation Guide. 

1.1 Integration Options 

Use the following process steps as a guideline to successfully integrate Employee Central with the time 

management provider. This is a simplified approach to a possible integration process. You will need to adjust 

these process steps based on the customer's business requirements. Following is an overview: 

1. Set up Employee Central. 

For more information, see the Employee Central Implementation Guide. 

2. Make third-party provider-specific settings, for example, SFTP server accessibility. 

3. Get access to the catalog in SAP HCI Spaces. 

4. Set up the data integration. 

5. If required by the customer, extend the data integration. 

1.2 Time Management Business Process with Kronos  

An API is implemented in Employee Central to extract the required employee data. SAP HANA Cloud Integration is 

used to call the API in Employee Central and collect the extracted employee data. 

Employee data is entered into Employee Central (new hire, retire, transfer, termination, change data) by the HR 

administrator, which is then replicated to Kronos via an SAP HANA Cloud Integration process using a standard flat 

file format. This employee data from Employee Central is then used for data that supports Kronos products. 

Following are the areas from Employee Central to Kronos data integration that are currently captured: 

 Employee master data (name, address) 

 Employment and job (including union information when applicable) 

 Compensation (annual salary, total compensation including bonus) 

 Dependent data 

 Life event notifications 

The integration is via a comma-delimited flat file (CSV) with Windows format reflected at Kronos daily via SFTP. 

The outcome of the outbound process is 2 files: 

  person_import_<company_territory_code>.txt 

  cost_center_import.txt 

http://service.sap.com/~sapidb/012002523100008617742014E
http://service.sap.com/~sapidb/012002523100008617742014E
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Kronos makes easy work of the tedious tasks involved with monitoring employee time and attendance. Kronos 

time-tracking works in tandem with data collection devices. This helps control labor costs, minimize compliance 

risk, and improve workforce productivity. 

Kronos provides employers and consumers with cloud-based technology to manage time and labor related 

information. Kronos then sends updates to Employee Central as required for legal reporting. 

The current solution looks at Employee Central sending the complete data about an employee and related 

information updates to Kronos. 

 

 

1.3 Overview of Payroll Export Process 

Kronos 

Time data is extracted from Kronos to a CSV file and saved in an SFTP location. 

SAP HANA Cloud Integration 

SAP HANA Cloud Integration accesses this SFTP location for the time data and transmits the time data to 

Employee Central Payroll via a Web service call. 

Employee Central Payroll 

1. When the XML file is received, it is automatically converted to an IDoc and can be seen in the IDoc queue. 

2. Report RBDAPP01 posts the records from the IDoc to SAP interface tables PTEX2000 (Absences) and 

PTEX2010 (Remuneration Wage Types). 

3. Report RPTEXTPT moves the data from the interface tables to the respective infotype tables, that is, PA2001 

(Absence Data) and PA2010 (Wage Types). 
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2 Employee Data Replication 

The replication of employee data from Employee Central to Kronos comprises the following steps: 

1. A scheduled SAP HANA Cloud Platform, integration service job extracts the employee data from Employee 

Central as of a certain date. 

2. The extracted data is mapped to and conforms to a File layout published by Kronos. 

3. SAP HANA Cloud Platform, integration service creates a (.txt) file and saves the same in SFTP location. 

4. After the data is received, employee import processing occurs within Kronos. 

 Note 

These specifications apply to the country version for the United States. If a customer implements any 

other country versions, some adjustments may be necessary. 

 Note 

All required data fields for configuring EmpCenter rules must be returned in a single row by the employee 

data extraction process via SAP HANA Cloud Platform, integration service. 

2.1 Prerequisites 

2.1.1 Configurations for Employee Central Compound Employee 
API 

The Compound Employee API for Employee Central pulls employee data from Employee Central. It returns 

employee data in a hierarchically structured response XML (root node: employee person data). 

Choose your regional API endpoint from the table below: 

Location End Point 

Europe https://api.successfactors.eu/sfapi/v1/soap 

USA, New Jersey https://api.successfactors.com/sfapi/v1/soap 

USA, Arizona https://api4.successfactors.com/sfapi/v1/soap 

 

Get the generic WSDL by adding ?wsdl to the above addresses. For example, 

https://api.successfactors.eu/sfapi/v1/soap?wsdl 

Apart from the endpoints, an XML schema is provided that describes the XML response of the compound API 

including all substructures and elements. The XML schema is required for integration purposes. It needs to be 
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maintained manually as part of the development process. The new API will only provide the query and the 

queryMore operation. All other operations such as list, describe, and describeEx are not supported. 

 

You may have to make the following settings: 

 Webservice setup 

Follow the standard process for SF APIs to set up SFAPI operations login and log out and to enable the API. 

 Thresholds and limits 

The API Compound Employee has similar thresholds and limitations as the other SFAPIs. You can set this 

number to a value between 1 and 800 by specifying the maxRows parameter in the query method. 

 API enhancements and compatibility 

The API response message type can be enhanced with additional elements and attributes. Additional 

elements and attributes can be supplied by SAP or SuccessFactors and by using custom fields. The external 

application must be able to process the extended response successfully. The API request message type can 

be enhanced by new processing and query string parameters (for example an additional parameter for 

selecting or filtering data). Enhancements of request message types and parameters are always optional. The 

system does not require the external application to provide optional values and parameter in the request. 

2.1.2 Preparations by Third-Party Provider 

Once a customer opts for a particular third-party provider's integration solution, the customer should sync on the 

following points for initial setup preparations to be done by the third-party provider: 

 Functional preparation 

For example, availability of a document such as Discovery and Requirements Gathering 

 Group and time plan setup 

o Technical setup of employee file 

For example, availability of documents such as Integration and Data Migration Discovery 

o SFTP server configuration 

2.2 Data Replication Specification 

The replication of employee master data from Employee Central to Kronos uses the CompoundEmployee  service 

from Employee Central. 

 

For information on Compound  Employee Element 

structure …  

See EC HRIS-element 

Personal Information  Personal Information [EC hris-element-id: personInfo] 

Phone information Phone Information [EC hris-element-id: phoneInfo] 

Email Information  E-mail Information [EC hris-element-id: emailInfo] 
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For information on Compound  Employee Element 

structure …  

See EC HRIS-element 

Employment Information Employment information [EC hris-element-id: 

employmentInfo] 

Job Information Job Information [EC hris-element-id: jobInfo] 

Pay Component Recurring Pay Component Recurring Information [EC hris-

element-id: paycomponentRecurring] 

 

The tables below list the different Employee Central Entities and fields required for replicating data from 

Employee Central using the middleware to the comma separated flat file format for Kronos. The tables also show 

the fields you need to map manually and the corresponding pick lists IDs for doing so. You will also find 

descriptions for mapping activities you need to do for which fields. 

2.2.1 Personal Information [EC hris-element-id: personInfo] 

EC Field Label Description 

Required/

Optional/C

onstant 

Code Mapping 

Required? 

Value 

Mapping Kronos Field 

First Name 

The person's 

first name. 

 

R 

  

First Name 

Middle Name 

The person's 

middle initial 

 

O 

 

X 

 

Middle Initial 

Last Name 
The person's 

last name.  
R 

  
Last Name 

Alt1 First Name 
The person's 

short name 
O 

  
Short Name 

Middle Name 

The Employee Central field Middle Name is mapped to the Kronos field Middle Initial through an SAP HANA Cloud 

Integration function. This function trims the characters in a string from the right to bring it to a fixed length. In this 

case, the fixed length is 1. 
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2.2.2 Phone Information [EC hris-element-id: phoneInfo] 

EC Field Label 

Description Required/

Optional/C

onstant 

Code Mapping 

Required? 

Value 

Mapping Kronos Field 

Phone 

Number 

The 

customer-

defined name 

of the contact 

category; up 

to three 

telephone 

numbers can 

be provided. 

O   

Phone 1 (Type: cell) 

Phone 2 (Type: home) 

Phone 3 (Type: office) 

2.2.3 E-mail Information [EC hris-element-id: emailInfo] 

EC Field 

Description 

Required/

Optional/ 

Constant 

Code 

Mapping 

Required? 

Value Mapping 

Kronos Field 

Name 

Email Address 

Employee's 

e-mail 

address 

(Type: 

Business) 

O 

  

Email Address 

2.2.4 Employment information [EC hris-element-id: 
employmentInfo] 

EC Field Description 

Required/

Optional/

Constant 

Code Mapping Required? Value 

Mapping 
Kronos Field 

Name 

Employment ID 

Person's 

identification 

number 

R   
Person 

Number 

Start Date 

Date on which 

the person 

was hired 

O   

Hire Date 

Employment ID Person's O   Badge Number 



 

12 

CUSTOMER  

© 2015 SAP SE or an SAP affiliate company. All rights reserved. 

SuccessFactors Employee Central and Kronos Workforce Central 

Employee Data Replication 

 

EC Field Description 

Required/

Optional/

Constant 

Code Mapping Required? Value 

Mapping 
Kronos Field 

Name 

badge 

number 

2.2.5 Job Information [EC hris-element-id: jobInfo] 

EC Field Label Description 

Required/

Optional/

Constant 

Code 

Mapping 

Required? 

Value Mapping 

Kronos Field 

EmplStatus 

Employment 

status of 

employee 

R 

X ValueMapping: 

EmploymentStatus Employment Status 

Start Date 

Latest 

effective date 

for changes in 

employee 

status 

O 

 

 Status Effective Date 

Cost_center 

Name of the 

labor level to 

which this 

labor level 

entry belongs 

R 

  

Labor Level 4 

Start Date  R 

 

 

Primary 

LaborAccount 

Effective Date 

Start Date 

Date that the 

pay rule 

becomes 

effective 

R 

  

Pay Rule Effective 

Date 

Is_fulltime_employee 

Name of the 

pay rule that is 

assigned to 

the employee 

R 

X ValueMapping: 

PayRule 
Pay Rule Name 

 

Time zone 

where the 

employee 

works 

R 

X ValueMapping: 

TimeZone 
Time Zone 

Manager_person_id 

Person 

number of the 

employee's 

O 

  

Reports To 
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EC Field Label Description 

Required/

Optional/

Constant 

Code 

Mapping 

Required? 

Value Mapping 

Kronos Field 

manager 

 

Whether the 

current 

employee is a 

manager 

O 

  

Manager License 

Employment Status 

The Employee Central field EmplStatus is mapped to the Kronos field Employment Status through the value 

mapping.EmploymentStatus. This table is defined as a value mapping in SAP HANA Cloud Integration and must be 

filled by the consumer based on the Kronos values. Default mapping values are available. 

Pay Rule Name 

The Employee Central field Is_fulltime_employee is mapped to the Kronos field Pay Rule Name through the value 

mapping PayRule. This table is defined as a value mapping in SAP HANA Cloud Integration and must be filled by 

the consumer based on the Kronos values. Default mapping values are available. 

Time Zone 

The Kronos field Time Zone is mapped through the value mapping TimeZone. This table is defined as a value 

mapping in SAP HANA Cloud Integration and must be filled by the consumer based on the Kronos values. Default 

mapping values are available. 

2.2.6 Pay Component Recurring Information [EC hris-
element-id: paycomponentRecurring] 

EC Field 

Description 

Required/

Optional/C

onstant 

Code Mapping 

Required? 

Value 

Mapping Kronos Field 

Name 

payCompValue 

Base wage 

rate for an 

employee 

O 

  

Base Wage Rate 

Start_date 

Effective 

date of the 

base wage 

rate 

O 

  

Base Wage Rate 

Effective Date 
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2.2.7 Address Information [EC hris-element-id: 
address_information] 

EC Field 

Description 

Required/

Optional/C

onstant 

Code 

Mapping 

Required? 

Value Mapping 

Kronos Field Name 

country 

Country Code O 

 ValueMapping: 

Mapping by 

Country 

Home Address Country 

state 

State O 

 ValueMapping: 

Mapping by 

Country 

Home Address State 

zip_code 

ZIP Code O 

 ValueMapping: 

Mapping by 

Country 

Home Address ZIP Code 

address_type 

Category of 

Address 
"home" 

 ValueMapping: 

Mapping by 

Country 

Category of Address 

city** 

City O 

X ValueMapping: 

Mapping by 

Country 

Home Address City 

address1-20** 

Address 1-20 O 

X ValueMapping: 

Mapping by 

Country 

Home Address Street 

Address Fields 

The mappings of the Kronos fields Home Address Street and Home Address City are country-dependent. Based 

on the country, these fields are mapped using the appropriate Employee Central fields. For information about 

country-dependent address field mappings, see Country-Specific Mappings of Address Fields in the appendix. 

2.3 Getting Access to the Solution 

SAP HCI Spaces is a Web-based application that helps you to access the integration content available for a 

particular tenant on an on-demand integration infrastructure. In SAP HCI Spaces, you can access integration 

packages with artifacts such as value mappings, integration flows, and files. For more information, see Viewing 

Integration Flow Configurations in the Developer's Guide for Managing Integration Content. 

You can edit and configure a package as follows: 

1. On the Discover tab, click the integration package to be configured. 

2. Choose Copy (as shown in the following figure). 

https://proddps.hana.ondemand.com/dps/d/preview/93810d568bee49c6b3d7b5065a30b0ff/2014.10/en-US/frameset.html?ec104a138bf64c849339a90588dd9f6c.html
https://proddps.hana.ondemand.com/dps/d/preview/93810d568bee49c6b3d7b5065a30b0ff/2014.10/en-US/frameset.html?ec104a138bf64c849339a90588dd9f6c.html
https://proddps.prod.jpaas.sapbydesign.com/dps/d/preview/dd250f2e3c2645a8ae327e935071281e/2014.12/en-US/DevGuide_ManageIntContent_External.pdf
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On the Design tab, you should now find the copied package. 

3. To configure and edit the package, follow Editing Integration Flow Configurations in the SAP HANA Cloud 

documentation. 

2.3.1 Common Configuration Steps 

2.3.1.1 SAP Credential Deployment 

To deploy the following artifacts, see Deploying and Editing a User Credentials Artifact in the Operations Guide for 

SAP HANA Cloud Integration. 

Artifact Description 

SuccessFactors EC Credentials These credentials are used to connect to the Employee 

Central system. 

SuccessFactors EC Payroll Credentials These credentials are used to connect to the Employee 

Central Payroll system. 

SAP SFTP Server Credentials These credentials are used to connect to the SFTP 

server. 

Kronos  SFTP Server Credentials These credentials are used to connect to the Kronos 

SFTP server. 

 

For more information about SFTP-based communication, see the Operations Guide for SAP HANA Cloud 

Integration. 

2.3.1.2 Value Mapping Maintenance 

A value mapping project is delivered along with the iFlows in this integration. It must be deployed in the customer 

landscape so that the iFlows can refer to the value mappings. For information about using and editing value 

mappings, see the Developer’s Guide for Managing Integration Content. 

https://proddps.hana.ondemand.com/dps/d/preview/93810d568bee49c6b3d7b5065a30b0ff/2014.10/en-US/frameset.html?1e556bced9b84c84889cadb7ccc79dd4.html
http://help.sap.com/cloudintegration/SAP_HCI_OpsGuide.pdf
http://help.sap.com/cloudintegration/SAP_HCI_OpsGuide.pdf
https://proddps.prod.jpaas.sapbydesign.com/dps/d/preview/fd2a6eae2a4f4d79a10dc8da1a48a034/2014.12/en-US/SAP_HCI_OperationsGuide_External.pdf
https://proddps.prod.jpaas.sapbydesign.com/dps/d/preview/fd2a6eae2a4f4d79a10dc8da1a48a034/2014.12/en-US/SAP_HCI_OperationsGuide_External.pdf
http://help.sap.com/cloudintegration/SAP_HCI_DevGuide.pdf
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2.4 Setting Up the Standard Data Integration 

In the Discover section, click the SuccessFactors EC with Third-Party Time Vendor — Kronos integration process 

and configure the EC to Kronos Workforce Central integration flow. 

 

 

2.4.1 Receiver Settings 

2.4.1.1 Query Compound Employee 

This receiver helps you to connect to Employee Central. 

 

Field Description 

Address Employee Central URL, for example, 

https://test.successfactors.com 

Credential Name Name of artifact that was deployed in Common 

Configuration Steps 

https://test.successfactors.com/


 

SuccessFactors Employee Central and Kronos Workforce Central 

Employee Data Replication 

 CUSTOMER  

© 2015 SAP SE or an SAP affiliate company. All rights reserved.  17 

 

2.4.1.2 Query FO_COSTCENTER 

This receiver helps you to connect to Employee Central. 

 

Field Description 

Address Employee Central URL, for example, 

https://test.successfactors.com 

Credential Name Name of artifact that was deployed in Common 

Configuration Steps 

2.4.1.3 SFTP Connection 

This receiver helps you to connect to the SFTP server of Kronos. 

 

Field Description 

Directory Directory name on the SFTP server where the resulting 

file is to be stored, for example, /Test 

Address SFTP server host URL, for example, test.sftp.com 

User Name Name of the artifact that was deployed in Common 

Configuration Steps 

https://test.successfactors.com/
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2.4.1.4 Logging: Error Reporting 

This receiver helps you to log the failing employees from the payload and to send the relevant information to a 

directory on the SFTP location. 

 

Field Description 

Directory Directory name on the SFTP server where the log is to 

be stored, for example, /Logs 

Address SFTP server host URL, for example, test.sftp.com 

User Name Name of the artifact that was deployed in Common 

Configuration Steps 

2.4.1.5 Exception Message 

This receiver helps you to log the exceptions that occur during a process run and to send the relevant information 

to a directory on the SFTP location. 

 

Field Description 

Directory Directory name on the SFTP server where the 

exceptions are to be stored, for example, /Logs 

Address SFTP server host URL, for example, test.sftp.com 

User Name Name of the artifact that was deployed in Common 

Configuration Steps 
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2.4.1.6 Employee Data Warning 

This receiver helps you to log the payload-related warnings during a process run and to send the relevant 

information to a directory on the SFTP location. 

 

Field Description 

Directory Directory name on the SFTP server where the 

warnings are to be stored, for example, /Logs 

Server Host SFTP server host URL, for example, test.sftp.com 

User Name Name of the artifact that was deployed in Common 

Configuration Steps 

 Note 

Currently, SAP HANA Cloud Integration does not expose the SFTP file name and archive directory to be 

changed at catalog level. If this is required, see Extending the Standard Data Integration. 

2.4.2 Parameters 

These parameters contain customizing options. To configure the parameters, you can override the default values. 
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Parameter Name Description 

KR_LAST_MODIFIED_ON In this dynamic process property, provide a timestamp value in the 

format yyyy-MM-ddTHH:mm:ss.SSSZ (for example, 2015-01-

01T00:00:00.000Z) for the first ever execution of the process. The 

process will then fetch the changes in the Employee Central system 

since the provided timestamp value. 

company_territory_code (Country) This is a mandatory field. Enter a single company_territory_code (ISO-

3). This field does not accept multiple values. The process will be 

terminated if this field is left blank. 

Avoid Generation of Cost Center File Allows you to avoid generating the cost center file. By default, the cost 

center file is generated. 

employee_class Comma-delimited list filter (no blank spaces before/after comma) for 

specifying the employee classes to include in the extract 

Company Comma-delimited list filter (no blank spaces before/after comma) for 

specifying the companies to include in the extract 

pay_group Include the foundation object externalCode if you want to include only 

employees associated with that foundation object 

Location Include the foundation object externalCode if you want to include only 

employees associated with that foundation object 

business_unit Include the foundation object externalCode if you want to include only 

employees associated with that foundation object 

person_id_external Comma-delimited list filter (no blank spaces before/after comma) for 

specifying the person_id_externals to include in the extract 

2.4.3 Value Mappings 

Value mappings are translation tables between the Employee Central picklist entries and the Kronos values. 

The following fields have been mapped through a value mapping project in SAP HANA Cloud Integration: 

 PayRule 

 EmploymentStatus 

 Mapping by Country 

 TimeZone 

You can modify the entries in this project to suit your needs. 

In the Developer’s Guide for Managing Integration Content, see Developing Value Mappings for general 

information about value mappings, and Editing the Value Mapping Project for information about editing value 

mappings. 

http://help.sap.com/cloudintegration/SAP_HCI_DevGuide.pdf


 

SuccessFactors Employee Central and Kronos Workforce Central 

Employee Data Replication 

 CUSTOMER  

© 2015 SAP SE or an SAP affiliate company. All rights reserved.  21 

 

2.5 Extending the Standard Data Integration 

This section describes cases where you want to enhance the current solution and to add custom fields. 

To make changes, you must be familiar with the following topics: 

 SAP HANA Cloud Integration process development 

SAP HANA Cloud Integration provides integration tools on the Eclipse platform to model integration flows, 

configure attributes of the integration flows, and deploy them to the runtime. For more information, see the 

Developer’s Guide for Managing Integration Content. 

 Employee Central compound APIs 

 Example 

You want to enhance the current process to adjust 10 custom fields in the destination file. In this case, the 

mapping palette of the SAP HANA Cloud Integration process needs to be changed to adjust the 10 user-

defined fields. Once the fields are introduced, you can choose to map the required field from Employee 

Central to the destination fields. 

http://help.sap.com/cloudintegration/SAP_HCI_DevGuide.pdf
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3 Integrating the Kronos UI 

You can enable single sign-on from the Employee Central UI as part of the integration with Kronos. 

3.1 Single Sign-On (SSO) 

This section describes how to configure a single sign-on connection to Kronos. 

Prerequisites 

 Provisioning user for a respective SFSF tenant is needed to maintain the SSO configuration. 

3.1.1 Employee Central Certification for Kronos 

Kronos needs the following data from SuccessFactors to configure SSO: 

1. Issuer ID 

Steps to be Performed  

1. Replace the values in the brackets to SFSF data center and the company id (tenant) respectively in 

the below link and provide the same to Kronos for SSO setup. 

https://[SFSF Data center servername]/sf/idp-init/sso/company/[companyid] 

For example, if the name of the SFSF data center server name is www.successfactors.com and the 

tenant or the company id is ABCDEFG, the link will be as follows: 

https://www.successfactors.com/sf/idp-init/sso/company/ABCDEFG  

2. SAML metadata & Signing Certificate  

This is the signing X509Certificate for SSO communication and can be taken from the X509Certificate-

Tag of SAML metadata file, 

Steps to be Performed  

1. Replace the values in the brackets to SFSF data center server name and the company id respectively in 

the below link and execute the link in a browser. 

https://[SFSF data center servername]/idp/samlmetadata?company=[companyid] 

For example, if the name of the SFSF data center server name is www.successfactors.com and the 

tenant or the company id is ABCDEFG, then the link will be as follows:  will look like below: 

https://www.successfactors.com/idp/samlmetadata?company=ABCDEFG  

You will be prompted to Download and save the file to disk.  

2. Open the file in a Notepad and remove all data except information in X509Certificate-Tag. (remove 

the red XML text) 

http://www.successfactors.com/
http://www.successfactors.com/
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3. Save the file (using SAVE AS) with a .cer extension and specify Unicode as encoding. The .cer file can be 

opened in Windows Explorer directly. 

 

o To save the certificate in different formats, go to detail tab in the certificate and click "copy to file". 

o This will start a wizard. Select DER as the format type to save as. 
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o Repeat the steps and save the certificate in Base 64 format. You will have two certificate files at the 

end of this step.  

4. Information about user identifying attributes 

5. The user ID comes in the name ID element of the SAML subject and that the company ID comes within the 

‘companyid’ attribute within the attribute statement as shown in the example. 

 

Note that the values in the square brackets are placeholders and must be replaced by the correct data. This 

information may be packaged in a metadata file. If you send the metadata file to Kronos, make sure you 

replace the entity ID within that file with the correct issuer ID. Kronos will use this information to setup SSO on 

their side.  

To set up SSO, the following information must be sent to Kronos:  Issuer ID / SAML metadata for the Company ID 

/ X509 Certificate / SAML User Attribute for Company ID. 

3.1.2 Configuration of Employee Central Identity Provider for 
Kronos 

Prerequisites 

Employee Central needs the following information from Kronos: 

 Assertion consumer service 

 Audience URL (optional) 

 Relay state value (optional) 

Task Steps 

1. Set up SSO Connection 

1. In Provisioning, select the company and then choose Authorized SP Assertion Consumer Settings. 
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2. Enter the assertion consumer service URL and audience string that you received from Kronos. 

 

3. Enter kronos-logonsp as the mapping key. 

3.1.3 Configure 'Time and Attendance' Link for Kronos 

2. Activating and Configuring Link to Kronos 

1. In Provisioning > Company Settings > Employee Central, select the Enable Employee Central V2 

timesheets link. 

2. Enter the target URL  

3. Note that the values in the square brackets are placeholders and must be replaced by the correct data. 

For example, if the SFSF data center server name is www.successfactors.com then the link will look like: 

https://www.successfactors.com/sf/idp-init/sso/kronos-logonsp?saml2=true 

http://www.successfactors.com/
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4 Time Data Replication 

This chapter describes how to export time data from Kronos to Employee Central Payroll. This process involves 

the following steps: 

Kronos 

Time data is extracted from Kronos to an XML file and saved in an SFTP location. 

SAP HANA Cloud Integration 

SAP HANA Cloud Integration accesses this SFTP location and transmits the time data to Employee Central Payroll 

using a Web service call. 

Employee Central Payroll 

1. When the flat file arrives in Employee Central Payroll, it is automatically converted to an IDoc and can be seen 

in the IDoc queue. 

2. Report RBDAPP01 posts the records from the IDoc to SAP interface tables PTEX2000 (absences) and 

PTEX2010 (remuneration wage types). 

3. Report RPTEXTPT moves the data from the interface tables to the respective infotype tables PA2001 

(absence data) and PA2010 (wage types). 

 Note 

These specifications apply to the country version for the United States. If a customer implements any 

other country version, some adjustments may be necessary. 

4.1 Utility Report 

From the May 2014 release onwards, the utility report to clear previous imports is delivered as standard in add-on 

SFIECPEP 100. We recommend using this standard utility report instead of the custom solution delivered in SAP 

Note 1915630. 

Prerequisites 

The following add-on is a prerequisite for using the standard utility report: 

SFIECPEP 100 SuccessFactors Employee Central Payroll Third-Party Data Integration Tool 

 

Report RPDELPTINT Delete Time Data from Interface Tables for External Providers 

Transaction PT_DEL_INT 

http://service.sap.com/sap/support/notes/1915630
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Following are some of the features of the utility program and how you can use it to clean up your system and make 

it ready to import the re-export from the third-party time and labor management (TLM) system. 

 A given batch of time data has a unique identifier. This unique identifier is stored in field CUSTOMER_FIELD of 

the IDoc segment. For any errors while importing time data, note down this CUSTOMER_FIELD. You need to 

specify this CUSTOMER_FIELD when executing the undo/delete utility report. 

 If the batch inserted time data into employee master data, the utility will delete it. If the batch deleted time 

data from employee master data, the utility will restore the deleted data. 

 The utility report will also delete the segments from the staging area of PTEX2010, PTEX2000, and PTEXDIR. 

 You can execute the utility report in test run mode. In this mode, the system simulates the actual execution 

and displays the result. You can also select a set of employees for simulation. 

 In a live run (the Test Run checkbox is not selected), you must process the delete report for the complete 

batch. You do this by executing the report with a given batch number in the selection parameter. Part delete is 

not allowed. 

 The utility report has built-in safety mechanisms to ensure system consistency. However, there is also a force 

delete mode to ignore such safety. This mode is useful if the system is in an inconsistent state and you want 

to delete a batch forcefully. 

4.2 Absence Data 

The following fields are considered during the replication: 

Kronos Emp 

Center Field 
Description 

Required/Optional/

Constant 

Code 

Mapping 

Required? 

Value 

Mapping 

Required? 

EC Payroll/IDoc 

Fields 

 

Partner system 

As configured in 

Receiver logical 

system of third-

party time 

management 

system, for 

example, KRONOS 

Yes No 

EXTSYSTEM 

 

External 

application 

"EXT", as defined in 

Checking External 

Application Key 

Yes No 

EXTAPPLICATION 
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Generated unique 

IDoc document 

number 

Required Yes No 

EXTDOCUMENTNO 

Batch Number 

Generated unique 

batch number 

Required Yes No 
CUSTOMER_FIELD 

Person Number 

Employee payroll 

ID as in EC Payroll 

(PERNR) 

Required No (direct 

map) 

No 
EMPLOYEENUMBE

R 

Date 

Start date and end 

date for the 

absence 

Required No No 
FROM_DATE, 

TO_DATE 

Kronos Pay Code Kronos pay code Required Yes Yes  

SuccessFactors 

Paycode Name 

Wage type code 

name as in EC 

Payroll 

Required Yes Yes 

 

SuccessFactors 

Paycode ID 

Absence/ 

attendance code 

Required No No 
ABS_ATT_TYPE 

Labor Level 4 

Cost center (for 

overriding default 

cost center 

assignment) 

Optional No No 

COSTCENTER 

Time 

Absence/ 

attendance hours 

Optional No No 
ABS_ATT_HOURS 

Unit of Time Unit of time  Optional No No  

Worked or 

Absence 

Employee's work 

(W) or absence (A) 

status 

Optional  No Yes 

 

Pay code wage 

rate 
Rate 

Optional No No 
 

Financial 

Company Code 

Company code of 

overriding cost 

center 

Optional No No 

COMP_CODE 

4.3 Remuneration Data 

The following fields are considered during the replication: 
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Kronos Emp Center 

Field 
Description 

Required/Optional/

Constant 

Code 

Mapping 

Required? 

Value 

Mapping 

Required? 

EC Payroll/IDoc 

Fields 

 

Partner 

system 

As configured in 

Receiver logical 

system of third-

party time 

management 

system, for 

example, KRONOS 

Yes No 

EXTSYSTEM 

 

External 

application 

"EXT", as defined in 

Checking External 

Application Key 

Yes No 

EXTAPPLICATION 

 

Generated 

unique IDoc 

document 

number 

Required Yes No 

EXTDOCUMENTNO 

Batch Number 

Generated 

unique batch 

number 

Required Yes No 

CUSTOMER_FIELD 

Person Number 

Employee 

payroll ID as 

in EC Payroll 

(PERNR) 

Required No No 

EMPLOYEENUMBER 

Date 

Date to which 

remuneration 

data belongs 

Required Yes No 

VALIDITYDATE 

Kronos Pay Code 

Kronos pay 

code 

Required No Yes 
 

SuccessFactors 

Paycode Name 

Wage type 

code name 

as in EC 

Payroll 

Required No Yes 

 

SuccessFactors 

Paycode ID 

Wage type 

code as in EC 

Payroll 

Required No Yes 

WAGETYPE 

Labor Level 4 Cost center Optional No Yes COSTCENTER 

Time 

Number of 

hours 

Optional No No 
NO_OF_HOURS 

Time 

Number 

Optional No Yes 

Value 

mapping: 

TimeUnit 

Number 
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Unit of Time 

Time unit for 

the number. 

The value is 

configured as 

in EC Payroll, 

for example, 

001 for 

Hours. 

Optional* No Yes 

Value 

mapping: 

TimeUnit TIME_UNIT 

Unit of Time 

Time unit for 

the number 

in ISO format 

Optional* No No 

TIME_UNIT_ISO 

Worked or Absence 

Employee's 

work (W) or 

absence (A) 

status 

Optional No Yes 

 

Pay Code Wage Rate Rate Optional No No VALUATION_BASIS 

Financial Company 

Code 

Company 

code of the 

overriding 

cost center 

Optional No No 

COMP_CODE 

* The fields are optional. However, some of them will be required based on the wage type configuration in 

Employee Central Payroll. 

4.3.1 Value Mappings 

The value mappings are translation tables between the Employee Central picklist entries and the Kronos values. 

The following fields have been mapped through a value mapping project in SAP HANA Cloud Integration: 

 TimeUnit 

You can modify the entries in this project to suit your needs. 

In the Developer’s Guide for Managing Integration Content, see Developing Value Mappings for general 

information about value mappings, and Editing the Value Mapping Project for information about editing value 

mappings. 

4.4 Getting Access to the Solutions 

SAP HCI Spaces is a Web-based application that helps you to access the integration content available for a 

particular tenant on an on-demand integration infrastructure. In SAP HCI Spaces, you can access integration 

packages with artifacts such as value mappings, integration flows, and files. For more information, see Viewing 

Integration Flow Configurations in the Developer's Guide for Managing Integration Content. 

You can edit and configure a package as follows: 

http://help.sap.com/cloudintegration/SAP_HCI_DevGuide.pdf
https://proddps.hana.ondemand.com/dps/d/preview/93810d568bee49c6b3d7b5065a30b0ff/2014.10/en-US/frameset.html?ec104a138bf64c849339a90588dd9f6c.html
https://proddps.hana.ondemand.com/dps/d/preview/93810d568bee49c6b3d7b5065a30b0ff/2014.10/en-US/frameset.html?ec104a138bf64c849339a90588dd9f6c.html
https://proddps.prod.jpaas.sapbydesign.com/dps/d/preview/dd250f2e3c2645a8ae327e935071281e/2014.12/en-US/DevGuide_ManageIntContent_External.pdf
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1. On the Discover tab, click the integration package to be configured. 

2. Choose Copy. 

On the Design tab, you should now find the copied package. 

To configure and edit the package, follow Editing Integration Flow Configurations in the SAP HANA Cloud 

documentation. 

4.4.1 Common Configuration Steps 

4.4.1.1 SAP Credential Deployment 

To deploy the following artifacts, see Deploying and Editing a User Credentials Artifact in the Operations Guide for 

SAP HANA Cloud Integration. 

Artifact Description 

SuccessFactors EC Credentials These credentials are used to connect to the 

SuccessFactors Employee Central system 

SuccessFactors EC Payroll Credentials These credentials are used to connect to the 

SuccessFactors Employee Central Payroll system 

SAP SFTP Server Credentials These credentials are used to connect to the SFTP 

server 

Kronos SFTP Server Credentials These credentials are used to connect to the Kronos 

SFTP server 

 

For more information about SFTP-based communication, see the Operations Guide for SAP HANA Cloud 

Integration. 

4.4.1.2 Value Mapping Maintenance 

A value mapping project is delivered along with the iFlows in this integration. It must be deployed in the customer 

landscape so that the iFlows can refer to the value mappings. For information about using and editing value 

mappings, see the Developer’s Guide for Managing Integration Content. 

4.4.2 Setting Up the Standard Data Integration 

In the Discover section, click the SuccessFactors EC with Third-Party Time Vendor — Kronos integration process 

and configure the Kronos WorkforceCentral to EC Payroll integration flow. 

https://proddps.hana.ondemand.com/dps/d/preview/93810d568bee49c6b3d7b5065a30b0ff/2014.10/en-US/frameset.html?1e556bced9b84c84889cadb7ccc79dd4.html
http://help.sap.com/cloudintegration/SAP_HCI_OpsGuide.pdf
http://help.sap.com/cloudintegration/SAP_HCI_OpsGuide.pdf
https://proddps.prod.jpaas.sapbydesign.com/dps/d/preview/fd2a6eae2a4f4d79a10dc8da1a48a034/2014.12/en-US/SAP_HCI_OperationsGuide_External.pdf
https://proddps.prod.jpaas.sapbydesign.com/dps/d/preview/fd2a6eae2a4f4d79a10dc8da1a48a034/2014.12/en-US/SAP_HCI_OperationsGuide_External.pdf
http://help.sap.com/cloudintegration/SAP_HCI_DevGuide.pdf
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4.4.2.1 Sender Settings 

4.4.2.1.1 Kronos SFTP 

 

Field Description 

Directory Directory name on the SFTP server where the input file 

is stored, for example, /input 

File Name Name of the input file along with the extension, for 

example, input.txt 

Address SFTP server host URL, for example, test.sftp.com 

User Name SFTP user name for the above connection 
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4.4.2.2 Receiver Settings 

4.4.2.2.1 Employee Central Payroll 

This receiver helps you to connect to the SuccessFactors Employee Central Payroll system. 

 

Field Description 

Address Employee Central Payroll connection URL 

Credential Name Name of the artifact that was deployed in Common 

Configuration Steps 

4.4.2.2.2 SFTP: Successful Records 

This receiver helps you to send the resulting file of the process to a directory at the SFTP location. 

 

Field Description 

Directory Directory name on the SFTP server where the resulting 

file is to be stored, for example, /Test 

Server Host SFTP server host URL, for example, test.sftp.com 
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User Name SFTP user name for the above connection 

4.4.2.2.3 SFTP: Error Records and Invalid Records 

This receiver helps you to log the failing employees from the payload and send the relevant information to a 

directory at the SFTP location. 

 

Field Description 

Directory Directory name on the SFTP server where the logs are 

to be stored, for example, /Logs 

Server Host SFTP server host URL, for example, test.sftp.com 

User Name SFTP user name for the above connection 

4.4.2.2.4 SFTP: System Values Missing 

This receiver helps you to capture the records where mandatory fields are missing from the payload, and to send 

the relevant information to a directory at the SFTP location. 

 

Field Description 

Directory Directory name on the SFTP server where the logs are 
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to be stored, for example, /Logs 

Address SFTP server host URL, for example, test.sftp.com 

User Name SFTP user name for the above connection 

 Note 

Currently, SAP HANA Cloud Integration does not expose the SFTP file name and archive directory to be 

changed at catalog level. If this is required, see Extending the Standard Data Integration. 

4.4.2.2.5 SFTP: Length Validations Fail 

This receiver helps you to capture the records where length validations fail on the payload and to send the 

relevant information to a directory at the SFTP location. 

 

Field Description 

Directory Directory name on the SFTP server where the logs are 

to be stored, for example, /Logs 

Address SFTP server host URL, for example, test.sftp.com 

User Name SFTP user name for the above connection 

 Note 

Currently, SAP HANA Cloud Integration does not expose the SFTP file name and archive directory to be 

changed at catalog level. If this is required, see Extending the Standard Data Integration. 
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4.4.2.2.6 Parameters 

 

 

Parameter Name Description 

Port Number of Sender Port number of the sender logical system 

Client Number of Receiver In transaction SM30, display table T000. Enter the client number that 

you want to use, for example, 502. 

Partner Number of Sender Logical system of the sender system configured in transaction BD64 

Partner Type of Sender Partner type of the sender system configured in the SAP ERP system 

Partner Type of Receiver Partner type of the receiver system configured in the SAP ERP system 

Port Number of Receiver Port number of the receiver logical system 

External System Receiver logical system of the third-party time management system. 

Enter the system from the Logical System step, for example, 

KRONOS. 

Partner Number of Receiver Logical system of the receiver system configured in transaction BD64 

CURRENCY 3-digit currency code, for example, USD 

Partner External Application ID As configured  in the IDoc 
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4.5 Details about the Data Replication 

General 

 EmpCenter will be the system of record for quotas/banks to facilitate accrual and usage calculations. 

 The inbound data from Kronos to EmployeeCentral Payroll will contain cost center related 

information.  Providing cost center in the inbound allows you to make use of cost override feature on 

Employee Central Payroll. This cost center information is the same as the one sent from Employee Central to 

Kronos as a part of Employee Data Replication. 

 As part of the paycode, Kronos may send Hours, Days or Amount. Based on this information, Wagetype is 

configured by the customer. 

Absence Data 

 Absence quota payouts are determined by the administrator in the time system (including accrual payouts at 

termination). 

 If you use integration with Infotype 2001, be aware that regardless of the absence hours that are sent from 

Kronos, the hours are recalculated again in SAP ERP Time Management based on the absence type 

configuration and the employee's work schedule in Infotype 0007. This is not be the case, when you use 

integration with Infotype 2010 for absence hours. You need to decide which infotype to use depending on 

your business needs and requirements. 

 If correct absence hours are relevant for Employee Central Payroll and cannot be handled using the 

remuneration infotype, then information on planned working time and public holidays must be held in sync 

with the planned working time in Kronos. You must configure the absence type calculation according to the 

customer's business requirements. Absences records must not be longer than a day. If they are longer, they 

need to split up into multiple absences, each only one a day long. For example, if there is a 4-days absence, it 

needs to be split into four records where each absence lasts only one day. 

 Absence codes sent to Employee Central Payroll may trigger business logic checks. We recommend that you 

select absence codes that have minimum or no business checks in Employee Central Payroll (for example, 

general absence with no collision checks and input checks). Absence codes which trigger business checks 

may require extensive configuration in Employee Central Payroll. 

Remuneration Data 

 Wage types are always expected to contain the number of hours and rate of pay. You can skip the rate if you 

want SAP to calculate the rate. 

 FLSA rates are calculated by default at Kronos. Customers need to use the custom fields for bonus data in 

SuccessFactors and this data needs to be transmitted to Kronos so that it calculates FLSA rates accurately. If 

customers want to use the FLSA rate calculated by Employee Central Payroll, they need to switch off the 

FLSA rate calculation in Kronos and instead have to configure the FLSA rate calculation in Employee Central 

Payroll. For more information, see subschema UTR0. 

 Wages are added to either the bonus pay component or the basic pay component based on the configuration 

in Employee Central Payroll. This influences subsequent payroll calculations. 

 For premium pay, there are two scenarios possible: 

o  Kronos sends wage types with the final rate of payment. 

In this case, you must change the configuration of wage types in Employee Central Payroll such that there 

is no further premium applied on the rate supplied by Kronos.  

o Kronos is configured to send the regular rate. 

In this case, the Employee Central Payroll configuration can contain premium rates. 
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 We recommend supplying cost center information only for override. If supplied in every case, it is assumed 

that the third-party provider takes care of sending amendments to Employee Central Payroll even if only the 

cost center changed for employees (for example, the cost center of an employee changed for the last period, 

but the time data remains the same). 

 For cost center overrides, only information for cost center is exposed from Employee Central Payroll.   

 Kronos needs to know the cost center/company codes that are valid in Employee Central Payroll.  This needs 

to be achieved by a custom integration. There is no standard integration available for this purpose. 

Functions Supported by the Payroll Export 

 Import of wage types into Employee Central Payroll = Infotype 2010 with valid date and amount of hours 

 Import of Absences into Employee Central Payroll = Infotype 2001 with valid date and hours 

 In case of terminated employees, the time data after the termination date is not processed. These cases have 

to be handled directly in Employee Central Payroll. 

 Absence quota payments will have to be determined by the administrator in the time system (including 

accrual payouts at termination). 

 In case of errors during the import of a particular batch of time data, the administrator needs to delete the 

complete batch. To achieve this, the batch number can be entered as a selection parameter when the Delete 

report is executed. Partial deletion is not allowed. For details about the Delete report, see the Error Correction 

section. 

 Time substitutions are out of scope. 

 Cancellation / deletion of absences previously exported to SAP payroll are out of scope 

 Cancellation / deletion of wage types previously exported to SAP payroll are out of scope 

4.6 Configuring the Integration between Kronos and 
Employee Central Payroll 

To enable the integration between Kronos and Employee Central Payroll, perform the following steps: 

 Configure Absence Types 

 Configure Remuneration Wage Types 

 Set up the ALE Scenario for IDoc 

4.6.1 Configuring Absence Types 

 Note 

If you don't use Time Management in SAP ERP, ensure that all time-based checks, for example, Input 

Checks or Quota Deduction Assignments, are deactivated. 

1. In the IMG, choose Time Management → Time Data Recording and Administration → Absences → Absence 

Catalog → Define Absence Types. 

2. Create only absence types that are relevant for payroll. For more information, see the documentation for the 

IMG activity. 
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3. In SM31, enter T554S and click Maintain. Double-click each payroll-relevant entry in the table and make the 

following settings for each: 

o In the Input Checks section, ensure the fields are either blank or unchecked. For minimum duration, enter 

001 and for maximum duration, enter 999.  

o In the Counting and Quota Deduction section, uncheck everything except Grpg att./abs. for counting (01).  

Enter a counting rule. 

o In the Payment Data section, enter an Absence Valuation Rule and Abs./Att cat. for Payroll as required by 

payroll calculation depending on the business demands of the absence valuation in payroll.  

Example SAP absence types are listed in the following table. As mentioned above, you can select absence types 

that have no checks. If you plan to select the other absence types, make sure that you deactivate the checks in the 

customizing. 

Absence Code Description Screens Used 

(and Subsequent 

Business Logic 

Applied) 

Collision Checks Input Checks Unit of Measure 

0100 
Paid Leave 

Quota 

Deduction 
Yes None Calendar Days 

0140 

Paid Absence General absence None 

End Date is 

required. 

Error if start 

and end date 

is an off day; 

or if the 

entire period 

is an off 

period. 

Calendar Days 

0150 Unpaid Absence General absence None None Calendar Days 

0200 

Illness Work Incapacity None 

Error - if 

absence is 

on a holiday 

Calendar Days 

0201 Short Term 

Disability 
Work Incapacity None None Calendar Days 

0202 Long Term 

Disability 
General absence None None Calendar Days 

0215 Comp Time for 

Overtime 

Quota 

Deduction 
Yes 

End Date is 

required 
Calendar Days 

0220 
Floating Holiday 

Quota 

Deduction 
Yes 

End Date is 

required 
Calendar Days 

0230 

Personal time General absence None 

End Date is 

required. 

Error if start 

and end date 

Calendar Days 
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4.6.2 Configuring Remuneration Wage Types 

1. In the IMG, select Personnel Management → Personnel Administration → Payroll Data → Employee 

Remuneration Information → Wage Types → Check Wage Type Characteristics. 

2. If a wage type already exists that fulfills customer requirements, use it. 

If not, do the following:  

o Select Personnel Management → Personnel Administration → Payroll Data → Employee Remuneration 

Information → Wage Types → Create Wage Type Catalog. 

o Select copy and enter a country. 

o Select wage type and click Copy. 

3. Adapt the wage type, if necessary, so that it exactly matches to the wage types that exist in Kronos. In the 

Input combination field, enter X for both Amount and Number/unit. In Number/unit section, choose a relevant 

entry for Time unit/mass, for example, Hours. 

For other sections, see the field documentation for more information.  

4. In SM31, enter V_512W_O and click Maintain. Choose the country grouping. Double-click the wage type and 

maintain the table according to the payroll requirements of the customer. 

Example SAP remuneration wage types are listed in the following table. 

Wage Type  Wage Type Description  Wage Type Characteristics  

M800  Regular working time  - Either amount or number/unit  

- Unit of measure: Hours  

- For basic hours  

- Add to total  

is an off day; 

or if the 

entire period 

is an off 

period. 

0250 Occ. Inj/Worker's 

Comp 
General absence None None Calendar Days 

0500 Maternity 

protection 

Maternity 

Protection 
Yes None Calendar Days 

0510 
Family care leave 

Maternity 

Protection 
Yes None Calendar Days 

0520 Jury Duty-Quota General absence None None Calendar Days 

0530 Bereavement Leave General absence None None Calendar Days 

0650 Military/non-

mil.service 
Military Service Yes None Calendar Days 

0700 Strike/Lockout General absence Yes None Calendar Days 
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M801  Lump sum period hours  - Either amount or number/unit  

- Unit of measure: Hours  

- For basic hours  

- Add to total  

M802  On Call/Standby  - Either amount or number/unit  

- Unit of measure: Hours  

- For basic hours  

- Add to total  

M803  Training - internal  - Either amount or number/unit  

- Unit of measure: Hours  

- For basic hours  

- Add to total  

M804  Training - external  - Either amount or number/unit  

- Unit of measure: Hours  

- For basic hours  

- Add to total  

M805  Overtime paid 1.0  - Either amount or number/unit  

- Unit of measure: Hours  

- For basic overtime hours  

- Add to total  

M806  Overtime paid 1.5  - Either amount or number/unit  

- Unit of measure: Hours  

- For for basic overtime hours  

- multiplied by 150%  

- Add to total  

M807  Overtime paid 2.0  - Either amount or number/unit  

- Unit of measure: Hours  

- For basic overtime hours  

- multiplied by 200%  

- Add to total  

M810  Sunday premium  - Either amount or number/unit  

- Unit of measure: Hours  

- multiplied by 25%  

- Bonus wage type  

- Add to total  

M811  Holiday premium  - Either amount or number/unit  

- Unit of measure: Hours  

- multiplied by 15%  

- Bonus wage type  

- Add to total  

M812  Evening Shift premium  - Either amount or number/unit  

- Unit of measure: Hours  

- multiplied by 5%  

- Bonus wage type  
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- Add to total  

M813  Night Shift premium  - Either amount or number/unit  

- Unit of measure: Hours  

- multiplied by 10%  

- Bonus wage type  

- Add to total  

M814  Weekend Shift premium  - Either amount or number/unit  

- Unit of measure: Hours  

- multiplied by 20%  

- Bonus wage type  

- Add to total  

M815  Call In pay  - Either amount or number/unit  

- Unit of measure: Hours  

- Bonus wage type  

- Add to total  

M850  Holiday Pay  - Either amount or number/unit  

- Unit of measure: Hours  

- For basic hours  

- Add to total  

M851  Vacation Pay  - Either amount or number/unit  

- Unit of measure: Hours  

- For basic hours  

- Add to total  

M852  Sick pay  - Either amount or number/unit  

- Unit of measure: Hours  

- For basic hours  

- Add to total  

M853  Comp time taken  - Either amount or number/unit  

- Unit of measure: Hours  

- For basic hours  

- Add to total  

M854  Jury duty  - Either amount or number/unit  

- Unit of measure: Hours  

- For basic hours  

- Add to total  

M855  Bereavement leave  - Either amount or number/unit  

- Unit of measure: Hours  

- For basic hours  

- Add to total  

M858  Family Medical Leave  - Either amount or number/unit  

- Unit of measure: Hours  

- For basic hours  

- Add to total  

M859  Maternity leave  - Either amount or number/unit  
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- Unit of measure: Hours  

- For basic hours  

- Add to total  

M860  Short term disability  - Either amount or number/unit  

- Unit of measure: Hours  

- For basic hours  

- Add to total  

M864  Other Paid Absence  - Either amount or number/unit  

- Unit of measure: Hours  

- For basic hours  

- Add to total  

ML01  Piecework time  - Either amount or number/unit  

- Unit of measure: Pieces  

- For basic hours  

- Add to total  

TD00  Direct tip  - Amount essential, no number/unit  

- For bonus  

- Add to total  

TGS0  Gross sales  - Amount essential, no number/unit  

- For bonus  

- Add to total  

TI00  Indirect tip  - Amount essential, no number/unit  

- For bonus  

- Add to total  

TO01  Overtime hours - tips  - No amount, number/unit essential  

- For bonus  

- Add to total  

TO02  Overtime hours - tips  - No amount, number/unit essential  

- For bonus  

- Add to total  

TR01  Regular hours - tips  - No amount, number/unit essential  

- For bonus  

- Add to total  

TR02  Regular hours - tips  - No amount, number/unit essential  

- For bonus  

- Add to total  

4.6.3 Configuring Technical Communication User 

To enable a customer specific integration scenario, the customer has to create a customer specific 

communication user for the inbound communication in the relevant payroll client. To ensure that the middleware 
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can successfully communicate with the payroll system,  create a technical user of type B (System User) with 

specific authorizations and restrictions.  

For your convenience, we have created a template role you can assign to this user: SAP_HR_PA_EC_EE_REPL. We 

strongly recommend that you create the user with this template role.  

Also be sure to mark this user as 'customer' user by assigning the user group “customer” to the user via SU01 – 

else the user will be automatically deleted. 

 Caution 

If the customer has already been using this template role since b1302, the customer must copy this 

template again and assign it to the user to ensure that Date Specifications, which are new to b1308, is 

replicated as well.  

For more information about creating users, see Creating a Technical User in the SAP Library. 

4.6.4 Setting up ALE Scenario for IDoc 

4.6.4.1 Defining a Logical System 

You must create a logical system that represents the third-party time management system. This will send the 

absence and remuneration data to the SAP system. 

 Note 

Logical systems are defined as cross-client systems. You must maintain the logical system in a client in 

which cross-client customizing is allowed. 

For more information, see the SAP ERP Implementation Guide (IMG) under SAP NetWeaver  Application Server 

 IDoc Interface / Application Link Enabling (ALE)  Basic Settings  Logical Systems  Define Logical Systems. 

1. In transaction BD54, select Edit  New Entries. 

2. Create a logical system that identifies the third-party time management  system, as shown in the following 

table: 

Field Entry 

Logical System Enter the logical system name of the third-party time 

management system, for example, WORKFORCE.  

Description Enter a descriptive name. 

4.6.4.2 Identifying the SAP System 

1. In transaction SM30, display table T000. 

2. Double-click the client you want to display (for example, 850). 
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3. Note the logical system specified here (example: XXXCLNT850) since this will be the system that receives the 

IDoc. 

4.6.4.3 Maintain Distribution Model 

You must define a distribution model for each system that receives data from SAP ERP. Distribution models 

describe the Application Link Enabling (ALE) message flows between logical systems.  

The distribution model consists of separate model views in which all the associated, cross-system message flows 

in your organization can be defined. These views must be distributed to the receiving systems. In the individual 

message flows you can define filters to determine which data is to be transferred to which receiving systems. The 

distribution model controls this distribution. 

For more information, see the SAP ERP Implementation Guide (IMG) under SAP NetWeaver  Application Server 

 IDoc Interface / Application Link Enabling (ALE)  Modelling and Implementing Business Processes  Edit 

Distribution Model and Distribute Views. 

1. In transaction BD64, switch to edit mode. 

2. Select Create Model View. 

3. Create a model view, as shown in the following tables: 

Field Value 

Short text For example, Employee Central Payroll – Third-Party Time Management 

System 

Technical 

Name 

For example, CP_WF_INT 

Maximum 10 characters 

Start Date <current date> 

End Data 31.12.9999 

4. In the Distribution Model list, select the model you just created and select Add Message Type. 

Fields and Values for hrsm_d 

Field Value Example 

Sender Logical system of SAP ERP 

<system ID>CLNT<client number> 

XXXCLNT850 

Receiver Receiver logical system of third-party time 

management system. 

Enter system from the Logical System step. 

WORKFORCE 

Message 

Type 

hrsm_d  

5. Select Add BAPI. 

6. For the following BAPIs, enter sender / receiver port as above: 

o Choose PTMgrExtAttAbs and then choose Method: InsertWithCostAssignment 

o Choose PTMgrExtRemunSpec and then choose Method: InsertWithCostAssignment 
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7. Save your entries. 

4.6.4.4 Checking and Registering IDoc Service 

1. To check if the service /sap/bc/srt/idoc (Inbound SOAP for IDoc) is active, proceed as follows:  

1. In transaction SICF, enter /sap/bc/srt/idoc in the Service Path field.   [Right-click IDoc, click test service, 

Web browser opens, the URL shown is the URL needed for the xml end point.] 

2. Choose Execute.  

If the service is displayed in gray, it is inactive. 

3. To activate the service, right-click the service name and choose Activate Service.  from the context menu. 

2. To register the service, proceed as follows: 

1. In transaction SRTIDOC, select the Register Service checkbox.  

2. In the Service Attributes section, enter the parameters: 

Parameter Value 

URI SOAP Application urn:sap-com:soap:runtime:application:idoc 

Name of Web Service Definition GENERIC 

Call Address (ICF Path) /sap/bc/srt/idoc 

Number of Virtual Host Leave empty 

3. Choose Execute. 

4.6.4.5 Maintain Partner Profile - Logical System (LS) 

This section describes how to configure partner profiles so that data is sent immediately. 

For more information, see the SAP ERP Implementation Guide (IMG) under SAP NetWeaver  Application Server 

 IDoc Interface / Application Link Enabling (ALE)  Modeling and Implementing Business Processes  Partner 

Profiles. 

Procedure 

1. In transaction WE20, select Partner Type LS and select Create. 

2. Create a partner profile, as shown in the following table: 

Field Value Example 

Partner No. Enter the logical system name   

Partner Type LS (Logical System)  

Type Organizational Unit or User (O or US)  
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Agent Enter the job (person or group of persons) to be notified in 

case of error 

50010120 

Language EN  

3. Save your entries. 

4. Click the Add Row icon to define the inbound parameters for the message type HRSM_D.  

Inbound Options tab for Message Type HRSM_D 

Field Value 

Message Type HRSM_D 

Process Code HRSM_D 

Processing By Function 

Module 

Trigger Immediately 

5. Ensure that Cancel Processing After Syntax checkbox is selected. 

4.6.4.6 Checking External Application Key 

1. In SM31, enter the table tptextapp and click Maintain. 

2. Ensure that there is a corresponding entry in the table for the external application field in the XML. If it is 

missing, add entry for external application for key EXT.  

4.6.4.7 Defining Background Jobs 

To move data from the IDoc to the correct infotype in the system., certain reports must be scheduled to run. 

1. In transaction SM36, click Job Wizard. 

2. Enter job name. Click Next.  

3. Choose ABAP Program Step. Click Next. 

4. Enter report RBDAPP01 as ABAP program name. Click Next. 

5. Click Start immediately. Click Next. 

6. Select periodical jobs. Click Next. 

7. Choose the interval period for how often the report should run, for example, every five minutes. 

8. Repeat the job wizard for report RPTEXTPT. The report should not use the option "Transfer/Delete". This is to 

make sure that the staging area data is retained. This data is required for the Error correction report. 
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4.7 Troubleshooting 

In exceptional cases, problems can occur with the data that is imported to Employee Central Payroll, for example, 

if an incorrect wage type code is attached to time entries. When errors occur, the export report fails and the 

administrator is notified. The batch needs to be re-exported from the EmpCenter and replicated in Employee 

Central Payroll. The administrator needs to access the EmpCenter and provide the unique batch ID for which the 

re-export of the time data is required. This unique batch ID is available in the IDoc field CUSTOMER_FIELD. 

Before the re-export is started, the previously imported data must be removed from the system. A cleanup is 

needed for both employee master data and the time data staging tables. From the May 2014 release onwards, we 

recommend using the standard utility report delivered in add-on SFIECPEP 100 to clean up the previous imports 

instead of the custom solution delivered through SAP Note 1915630. For lower releases, SAP Note 1915630 

describes a utility report that cleans up this data. Please implement this SAP note in the customer's Employee 

Central Payroll system. Follow the instructions in the SAP note carefully to execute the report correctly.  

http://service.sap.com/sap/support/notes/1915630
http://service.sap.com/sap/support/notes/1915630
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5 Appendix 

5.1 Country-Specific Mappings of Address Fields 

The mapping of some of the Kronos address fields is dependent on the country. The following table shows the 

mappings between the Employee Central fields and the Kronos fields Home Address Street and Home Address 

City based on the country. 

 

Country Home Address Street Home Address City 

Argentina address1 city 

Australia address1 city 

Austria address1 city 

Brazil address1 city 

Canada address1 city 

Chile address2 city 

China address2 city 

Finland address1 city 

France address2 city 

Germany address1 city 

Hong Kong address2 - 

India address1 city 

Ireland address1 city 

Italy address1 city 

Japan - address1 

Korea address3 address1 

Malaysia address1 city 

Mexico address1 city 

Netherlands address3 city+address2 

New Zealand address3 city 

Russia address1 city 

Singapore address1 city 
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Spain address1 city 

Sweden address1 city 

Switzerland address1 city 

United Kingdom address1 city 

United States address1 city 

Venezuela address1 city 

DEFAULT** address1 city 

NOTE 

** The standard implementation provides country-dependent address mapping for the countries listed in the 

above table. For all other countries the DEFAULT mapping is used. 





 

 

 

www.sap.com/contactsap 

© 2015 SAP SE or an SAP affiliate company. All rights reserved. 

No part of this publication may be reproduced or transmitted in any 

form or for any purpose without the express permission of SAP SE 

or an SAP affiliate company. 

SAP and other SAP products and services mentioned herein as well 

as their respective logos are trademarks or registered trademarks of 

SAP SE (or an SAP affiliate company) in Germany and other 

countries. All other product and service names mentioned are the 

trademarks of their respective companies. Please see http://www. 

sap.com/corporate-en/legal/copyright/index.epx#trademark for 

additional trademark information and notices. 

Material Number:  

 

http://www.sap.com/corporate-en/legal/copyright/index.epx#trademark
http://www.sap.com/corporate-en/legal/copyright/index.epx#trademark

	securitylevel
	maintitle
	OLE_LINK1
	OLE_LINK2
	copyright

